Введение
Исходя из структуры и содержания методического пособия, оно будет полезно следующим категориям читателей:

· студентам технических специальностей колледжей и вузов, изучающим информационные технологии как самостоятельную дисциплину;

· преподавательскому составу, осуществляющему  практическую подготовку студентов по дисциплине «Информационные технологии»;

· преподавателям иных дисциплин, использующим персональные компьютеры в качестве технического средства обучения и (или) средства подготовки учебно-методических материалов (бумажных и электронных) по своей предметной области;

· лицам, самостоятельно изучающим или осваивающим дисциплину «Информационные технологии» на практике;

Практическая работа № 1

Тема: СОЗДАНИЕ ДЕЛОВЫХ ДОКУМЕНТОВ
Цель занятия. Изучение информационной технологии создания, сохранения и подготовки к печати документов.
Задание 1.1. Оформить приглашение по образцу.
Порядок работы
1. Запустите текстовый редактор.
2. Установите нужный вид экрана, например — Разметка страницы (Вид/Разметка страницы).
3. Установите параметры страницы (размер бумаги — А4; ориентация — книжная; поля: левое — 3 см, правое — 1,5 см, верхнее — 3 см, нижнее — 1,5 см), используя команду Файл/Параметры стра​ницы (вкладки Поля и Размер бумаги)
4.Установите межстрочный интервал — полуторный, выравни​вание — по центру, используя команду Формат/Абзац.

5. Наберите текст, приведенный ниже (текст можно изменить и дополнить). В процессе набора текста меняйте начертание, размер шрифта (для заголовка — 14 пт.; для основного текста — 12 пт. типы выравнивания абзаца — по центру, по ширине, по правому краю), используя кнопки на панелях инструментов.

Образец задания
[image: image5.wmf]ПРИГЛАШЕНИЕ
Уважаемый 

господин Яков Михайлович Орлов!

Приглашаем Вас на научную конференцию

 «Информатиза​ция современного общества».
Конференция состоится 20 ноября 2003 г. в 12.00 

в конфе​ренц-зале Технологического колледжа.
Ученый секретарь                                        С.Д.Петрова
6. Заключите текст  приглашения в рамку и произведите цветовую заливку.
7. Вставьте рисунок в текст приглашения {Вставка/Рисунок/Кар​тинки); задайте положение текста относительно рисунка — «Вок​руг рамки» {Формат/Рисунок/Положение/Вокруг рамки).

8. Скопируйте дважды на лист типовое приглашение {Правка/ Копировать, Правка/Вставить).

9. Отредактируйте лист с полученными двумя приглашениями и подготовьте к печати {Файл/Предварительный просмотр).

Задание 1.2. Оформить докладную записку по образцу.

Краткая справка. Верхнюю часть докладной записки оформляйте в виде таблицы (2 столбца и 1 строка; тип линий —  нет границ). Этот прием оформления позволит выполнить разное выравнивание в ячейках таблицы: в левой ячейке — по левому краю, в правой — по центру.

Образец задания

Сектор аналитики и экспертизы
Директору Центра ГАНЛ 



Н.С. Петрову

ДОКЛАДНАЯ ЗАПИСКА

03.11.2002

Сектор не может завершить в установленные сроки экспертизу проекта маркетингового исследования фирмы «Астра-Н» в связи с  отсутствием полных сведений о финансовом состоянии фирмы.

Прошу дать указания сектору технической документации предоставить полные сведения по данной фирме.

Приложение: протокол о некомплектности технической документации фирмы «Астра-Н».

Руководитель сектора
аналитики и экспертизы
{подпись)
М. П. Спелов

Задание 1.3. Создать справку личного характера.
Образец задания
ОАО «Вестор» 

СПРАВКА
08.11.2003 №45   

Москва
Васильева Ольга Ивановна работает в должности ведущего спе​циалиста ОАО «Вестор».
Должностной оклад — 4750 р.
Справка выдана для предоставления по месту требования.

Начальник отдела кадров
(подпись)
П.П. Спелов

Задание 1.4. Создать краткий протокол.
Образец задания
ОАО «Вестор» ПРОТОКОЛ
08.11.2004 №27
заседания Совета директоров
Председатель — А. С. Серов 

Секретарь — Н. С. Иванчук 

Присутствовали: 7 человек (список прилагается) 

Приглашенные: Заместитель директора «Книжной палаты» Н. Ш. Стрелков.
РАССМОТРЕННЫЕ ВОПРОСЫ:
1. Организационные вопросы.
2. О проекте иллюстрированного издания о деятельности фир​мы.
ПРИНЯТЫЕ РЕШЕНИЯ:
1. А. А. Сидорову подготовить проект штатного расписания на 2004 г.
2. Поручить члену научно-информационной комиссии К. С. Пе​трову согласовать проект издания с «Книжной палатой».
Председатель
(подпись)
А. С. Серов
Секретарь
(подпись)
Н. С. Иванчук
Практическая работа № 2
Тема: ОФОРМЛЕНИЕ ТЕКСТОВЫХ ДОКУМЕНТОВ, СОДЕРЖАЩИХ ТАБЛИЦЫ
Цель занятия. Создание документов, с использованием таблиц. Форматирование и редактирование таблиц.
Задание 2.1. Создать таблицу по образцу, используя объедине​ние ячеек.
Порядок работы
1. Наберите таблицу изменения роста поставок компьютерного оборудования за 1995... 1999 гг. по приведенному образцу, исполь​зуя объединение ячеек (Таблица/Объединить ячейки).
	% поставок
	годы

	
	1995
	1997
	1999

	
	27%
	18%
	22%


Задание 2.2. Создать таблицу, используя табуляцию.

Объем персональных компьютеров, тыс. р.
Компания
1998 г.
1999 г.
Compag
13266
15732,01
IBM
7946
9287,007
Dell
7770
11883,2
Hewlett-Packard
5743
7577,035
Packard BellNEC
5976
5989,07
Задание 2.3. Оформить документ, содержащий таблицу, по об​разцу. Произвести расчет штатной численности по каждой группе оплаты труда.
Краткая справка. Верхнюю часть документа оформите с использованием таблицы (тип линий — нет границ). Произведи​те расчет суммы по столбцам (на месте вопросов должны стоять цифры). Расчет производится через меню Таблица/формула
ОАО «Прогресс»
Утверждаю
23.12.2002 № 38
Генеральный директор
Москва

 Б.Н.Добров
03.11.2003
Структура и штатная численность ОАО «Прогресс» на 2003 г.
	Наименование должностей
	Штатная численность и группы по оплате труда

	
	Первая
	Вторая
	Третья
	Четвертая
	Пятая

	Генеральный директор
	1
	
	
	
	

	Главный бухгалтер
	1
	
	
	
	

	Сотрудники бухгалтерии
	
	2
	2
	
	

	Старшие специалисты
	
	3
	7
	1
	

	Специалисты
	
	
	4
	5
	6

	Итого
	?
	?
	?
	?
	?


Дополнительное задание
Задание 2.4 Оформите таблицу анализа объема выпуска продукции по изделиям в соответствии с образцом. Произведите расчеты в таблице.
Краткая справка. Для изменения направления текста выделите группу ячеек и воспользуйтесь командой Формат/ Направление текста.
	Номенклатурный номер
	Единица измерения
	Июль  2003г.
	Август 2003г.
	Сентябрь 2003 г.

	14 5 78
	шт.
	45 782
	57896
	41963

	457892
	шт.
	78952
	95824
	85 236

	198624
	шт.
	12457
	46721
	63 852

	6256
	шт.
	36985
	75 841
	74125

	164676
	шт.
	85 924
	72921
	26292

	Итого:
	шт.
	?
	?
	?


Практическая работа № 3
Тема: СОЗДАНИЕ КОМПЛЕКСНЫХ ДОКУМЕНТОВ В ТЕКСТОВОМ РЕДАКТОРЕ
Цель занятия. Изучение технологии создания комплексных до​кументов.
Задание 3.1. Создать текстовый документ, содержащий рисунок в виде схемы и маркированный список.
Порядок работы
1. Запустите текстовый редактор Microsoft Word.
2. Разверните окно редактора на весь экран. Установите вид — «Разметка страницы»; масштаб — 85 %.
3. Задайте все поля страницы по 2,5 см.
4.
Перед началом набора текста установите размер шрифта — 12 пт.; вид — курсив и гарнитуру шрифта — Times New Roman Cyr.
5.
Командами Формат/Абзац задайте следующие параметры:
межстрочный интервал — множитель 1,2;
выравнивание — по ширине.
6.
Командами Сервис/Язык/Расстановка переносов установите автоматическую расстановку переносов.
7.
Наберите образец текста. Образец содержит один абзац текста,
рисунок в виде схемы и маркированный список.
Краткая справка. Для создания схемы воспользуйтесь возможностями панели Рисование (Вид/Панели инструментов/Рисование). После создания схемы проведите группировку для того, чтобы вся схема воспринималась как единый графический объект. Для этогo выделите всю схему при помощи кнопки Выбор объекта панели Рисование, нажмите на кнопку Действия и выберите команду Группировать.
Образец задания
Информационное письмо
Методология планирования материальных ресурсов производствa (MRP) обеспечивает ситуацию, когда каждый элемент производства, каждая комплектующая деталь находится в нужное время и нужном количестве (рис. 1).
На основании входных данных MRP-система выполняет следующие операции:



Рис 1 Структурная схема MRP
 Задание 3.2. Оформить схемы по образцу. 
  Схема 1.
	Планирование ресурсов
	
	Планирование производства
	
	Предварительный бюджет закупок

	
	
	
	
	Предварительный
график загрузки
мощностей

	Управление спросом
	
	Предварительный

График загрузки

мощностей









Схема 2.


[image: image1]
Схема 3


[image: image2]
Задание 3.3 Оформить документ по образцу.



Элементарные операции ин​формационного процесса вклю​чают:

•
сбор, преобразование информации, ввод в компьютер;


 передача информации;
•
хранение и обработку информации;
•
предоставление информации пользователю.
Все персональные компьютеры (ПК) можно разделить на не​сколько категорий:
· мобильные компьютеры — карманные (ручные) и блокнот​ные, или планшетные ПК (ноутбук), а также надеваемые компь​ютеры и телефоны-компьютеры;

· базовые настольные ПК — универсальные компьютеры и ПК для «цифрового дома»;

· специализированные ПК — сетевые компьютеры, рабочие станции и серверы высокого уровня;

· суперкомпьютерные системы.

Пути развития традиционной индустрии информационных тех​нологий намечают корпорации Microsoft и Intel. Некий усреднен​ный компьютер согласно стандарту РС 2001 имеет следующие па​раметры :
	Критерий
	Персональный компьютер
	Рабочая станция

	Процессор
	от 500 МГц
	от 700 МГц

	Кэш L2
	от 128 Кбайт
	от 512 Кбайт

	Память
	от 64 Мбайт
	от 1284 Мбайт


Практическая работа № 4

Тема: Создание табличных документов.Обработка данных
Цель занятия: Научиться создавать таблицы, с помощью Microsoft Excel, пользоваться автозаполнением и научиться производить расчеты с помощью формул.
Задание 4.1
1. Запустите программу Excel (Пуск > Программы > Microsoft Excel).

2. Создайте новую рабочую книгу (кнопка Создать на стандартной панели инструментов).

3. Дважды щелкните на ярлычке текущего рабочего листа и дайте этому рабочему листу имя Данные.

4. Сделайте текущей ячейку А1 и введите в нее заголовок Результаты измерений.

5. Введите произвольные числа в последовательные ячейки столбца А, начиная с ячейки А2.

6. Введите в ячейку В1 строку Удвоенное значение.

7. Введите в ячейку С1 строку Квадрат значения.

8. Введите в ячейку D1 строку Квадрат следующего числа.

10. Введите в ячейку В2 формулу =2*А2.

11. Введите в ячейку С2 формулу =А2*А2.

12. Введите в ячейку D2 формулу =В2+С2+1.

13. Выделите протягиванием ячейки В2, С2 и D2.

14. Наведите указатель мыши на маркер заполнения в правом нижнем углу рамки, охватывающей выделенный диапазон. Нажмите левую кнопку мыши и перетащите этот маркер, чтобы рамка охватила столько строк в столбцах В, С и D, сколько имеется чисел в столбце А.

15. Убедитесь, что формулы автоматически модифицируются так, чтобы работать со значением ячейки в столбце А текущей строки.

16. Измените одно из значений в столбце А и убедитесь, что соответствующие значения в столбцах В, С и D в этой же строке были автоматически пересчитаны.

17. Введите в ячейку Е1 строку Масштабный множитель.

18. Введите в ячейку Е2 число 5.

19. Введите в ячейку F1 строку Масштабирование.

20. Введите в ячейку F2 формулу =А2*Е2.

21. Используйте метод автозаполнения, чтобы скопировать эту формулу в ячейки столбца F, соответствующие заполненным ячейкам столбца А.

22. Убедитесь, что результат масштабирования оказался неверным. Это связано с тем, что адрес Е2 в формуле задан относительной ссылкой.

23. Щелкните на ячейке F2, затем в строке формул. Установите текстовый курсор на ссылку Е2 и нажмите клавишу F4. Убедитесь, что формула теперь выглядит как =А2*$Е$2, и нажмите клавишу ENTER.

24. Повторите заполнение столбца F формулой из ячейки F2.

Упражнение 2. Применение итоговых функций
1. Выберите рабочий лист Данные.

2. Сделайте текущей первую свободную ячейку в столбце А.

3. Щелкните на кнопке Автосумма на стандартной панели инструментов.

4. Убедитесь, что программа автоматически подставила в формулу функцию СУММ и правильно выбрала диапазон ячеек для суммирования. Нажмите клавишу ENTER.

5. Сделайте текущей следующую свободную ячейку в столбце А.

6. Щелкните на кнопке Вставка функции на стандартной панели инструментов.

7. В списке Категория выберите пункт Статистические.

8. В списке Функция выберите функцию СРЗНАЧ и щелкните на кнопке ОК.

10. Переместите методом перетаскивания палитру формул, если она заслоняет нужные ячейки. Обратите внимание, что автоматически выбранный диапазон включает все ячейки с числовым содержимым, включая и ту, которая содержит сумму. Выделите правильный диапазон методом протягивания и нажмите клавишу ENTER.

11. Используя порядок действий, описанный в пп. 6-10, вычислите минимальное число в заданном наборе (функция МИН), максимальное число (МАКС), количество элементов в наборе (СЧЕТ).

Упражнение 3. Подготовка и форматирование прайс-листа

1. Запустите программу Excel (Пуск > Программы > Microsoft Excel) и откройте рабочую книгу упражнения.

2. Выберите щелчком на ярлычке неиспользуемый рабочий лист или создайте новый (Вставка > Лист). Дважды щелкните на ярлычке нового листа и переименуйте его как Прейскурант.

3. В ячейку А1 введите текст Прейскурант и нажмите клавишу ENTER.

4. В ячейку А2 введите текст Курс пересчета: и нажмите клавишу ENTER. В ячейку В2 введите текст 1 у.е.= и нажмите клавишу ENTER. В ячейку С2 введите текущий курс пересчета и нажмите клавишу ENTER.

5. В ячейку A3 введите текст Наименование товара и нажмите клавишу ENTER. В ячейку ВЗ введите текст Цена (у.е.) и нажмите клавишу ENTER. В ячейку СЗ введите текст Цена (руб.) и нажмите клавишу ENTER.

6. В последующие ячейки столбца А введите названия товаров, включенных в прейскурант.

7. В соответствующие ячейки столбца В введите цены товаров в условных единицах.

8. В ячейку С4 введите формулу: =В4*$С$2, которая используется для пересчета цены из условных единиц в рубли.

9. Методом автозаполнения скопируйте формулы во все ячейки столбца С, которым соответствуют заполненные ячейки столбцов А и В. Почему при таком копировании получатся верные формулы?

10. Измените курс пересчета в ячейке С2. Обратите внимание, что все цены в рублях при этом обновляются автоматически.

11. Выделите методом протягивания диапазон А1:С1 и дайте команду Формат > Ячейки. На вкладке Выравнивание задайте выравнивание по горизонтали По центру и установите флажок Объединение ячеек.

12. На вкладке Шрифт задайте размер шрифта в 14 пунктов и в списке Начертание выберите вариант Полужирный. Щелкните на кнопке ОК.

13. Щелкните правой кнопкой мыши на ячейке В2 и выберите в контекстном меню команду Формат ячеек. Задайте выравнивание по горизонтали По правому краю и щелкните на кнопке ОК.

14. Щелкните правой кнопкой мыши на ячейке С2 и выберите в контекстном меню команду Формат ячеек. Задайте выравнивание по горизонтали По левому краю и щелкните на кнопке ОК.

15. Выделите методом протягивания диапазон В2:С2. Щелкните на раскрывающей кнопке рядом с кнопкой Границы на панели инструментов Форматирование и задайте для этих ячеек широкую внешнюю рамку (кнопка в правом нижнем углу открывшейся палитры).

16. Дважды щелкните на границе между заголовками столбцов А и В, В и С, С и D. Обратите внимание, как при этом изменяется ширина столбцов А, В и С.

17. Посмотрите, устраивает ли вас полученный формат таблицы. Щелкните на кнопке Предварительный просмотр на стандартной панели инструментов, чтобы увидеть, как документ будет выглядеть при печати.

18. Щелкните на кнопке Печать и напечатайте документ.

19. Сохраните рабочую книгу.

Упражнение 4. Построение экспериментального графика
1. Запустите программу Excel (Пуск > Программы > Microsoft Excel) и откройте рабочую книгу, созданную ранее.

2. Выберите щелчком на ярлычке неиспользуемый рабочий лист или создайте новый (Вставка > Лист). Дважды щелкните на ярлычке листа и переименуйте
его как Обработка эксперимента.

3. В столбец А, начиная с ячейки А1, введите произвольный набор значений независимой переменной.

4. В столбец В, начиная с ячейки В1, введите произвольный набор значений функции.

5. Методом протягивания выделите все заполненные ячейки столбцов А и В.

6. Щелкните на значке Мастер диаграмм на стандартной панели инструментов.

7. В списке Тип выберите пункт Точечная (для отображения графика, заданного парами значений). В палитре Вид выберите средний пункт в первом столбце (маркеры, соединенные гладкими кривыми). Щелкните на кнопке Далее.

8. Так как диапазон ячеек был выделен заранее, мастер диаграмм автоматически определяет расположение рядов данных. Убедитесь, что данные на диаграмме выбраны правильно. На вкладке Ряд в поле Имя укажите: Результаты измерений. Щелкните на кнопке Далее.

9. Выберите вкладку Заголовки. Убедитесь, что заданное название ряда данных автоматически использовано как заголовок диаграммы. Замените его, введя в поле Название диаграммы заголовок Экспериментальные точки. Щелкните на кнопке Далее.

10. Установите переключатель Отдельном. По желанию, задайте произвольное имя добавляемого рабочего листа. Щелкните на кнопке Готово.

И. Убедитесь, что диаграмма построена и внедрена в новый рабочий лист. Рассмотрите ее и щелкните на построенной кривой, чтобы выделить ряд данных.

12. Дайте команду Формат > Выделенный ряд. Откройте вкладку Вид.

13. На панели Линия откройте палитру Цвет и выберите красный цвет. В списке Тип линии выберите пунктир.

14. На панели Маркер выберите в списке Тип маркера треугольный маркер. В палитрах Цвет и Фон выберите зеленый цвет.

15. Щелкните на кнопке ОК, снимите выделение с ряда данных и посмотрите, как изменился вид графика.

16. Сохраните рабочую книгу.

Упражнение 5. Решение задачи табулирования функции.

Цель работы: закрепить навыки по заполнению и редактированию таблицы; познакомиться со способами адресации; освоить некоторые приемы оформления таблиц.

Дальнейшее знакомство с Excel осуществим на примере задачи табулирования функции.
Постановка задачи:
Вычислить значения функции у=к*(х^2-1)/(х^2+1) для всех х на интервале [-2,2] с шагом 0,2 при к=10.

Решение должно быть получено в виде таблицы:

	№
	Х
	К
	У= к*(х^2-1)/(х^2+1)

	
	
	
	

	
	
	
	


ЗАДАНИЕ 1. Заполните основную и вспомогательную таблицы.
2.1 .Заполните шапку основной таблицы, начиная с ячейки А1.
2.2. Заполните вспомогательную таблицу начальными исходными данными,
начиная с ячейки Н1:
	Х1
	Step
	К

	-2
	0,2
	10


где х1 - начальное значение X; 

step     - шаг изменения X; 

к        - коэффициент (const).

Данный пункт при решении задачи табулирования функции является необязательным и введен искусственно для демонстрации способов адресации.
2.3. Используя функцию автозаполнения, заполните столбец А числами от 1
до21, начиная с ячейки А2 и заканчивая ячейке А22 
2.4. Заполните столбец В значениями X:

■
в ячейку В2 занесите =$Н$2.

Это означает, что в ячейку В2 заносится значение из ячейки Н2 (начальное значение X), знак $ указывает на абсолютную адресацию.

■
в ячейку ВЗ занесите =B2+$I$2.

Это означает, что начальное значение X будет увеличено на величину шага, которая берется из ячейки 12.

Заполните этой формулой ячейки В4: В22.

Столбец заполнится значениями X от-2 до 2 с шагом 0,2.

2.5.
Заполните столбец С значениями коэффициента К:
· в ячейку С2 занесите =$J$2,

· в ячейку СЗ занесите =С2.
Посмотрите на введенные формулы. Почему они так записаны? Заполните этой формулой ячейки С4:С22. Весь столбец заполнился значением 10.

2.6.
Заполните столбец D значениями функции у1= к*(х^2-1)/(х^2+1)

в ячейку D2 занесите формулу подставляя значения переменных из 2-ой строки, далее заполните этой формулой ячейки D3:D22.

Проверьте! Значения функции как положительные, так и отрицательные. Начальное значение 6. Конечное значение 6.

ЗАДАНИЕ 2. Понаблюдайте за изменениями в основной таблице при смене данных во вспомогательной.
3.1. Смените во вспомогательной таблице начальное значение х1, в ячейку Н2 занесите -5.

3.2. Смените значение шага, в ячейку I2 занесите 2.

3.3. Смените значение коэффициента, в ячейку J2 занесите 1.

Внимание! При всех изменениях данных во вспомогательной таблице в основной таблице пересчет производится автоматически.

3.4.
Прежде чем продолжить работу, верните прежние начальные значения во
вспомогательной таблице:
хО=-2; step=0,2; k=10.

ЗАДАНИЕ 3. Оформите основную и вспомогательную таблицы.
4.1.
Вставьте 2 пустые строки сверху для оформления заголовков:
· установите курсор на 1 строку;

· выполните команды меню ВСТАВКА, Строки (2 раза).

4.2.
Занесите заголовки:
· в ячейку А1 Таблицы,
· в ячейку А2 основная,
· в ячейку Н2 вспомогательная.

4.3.
Объедините ячейки А1:J1 и напишите заголовок "Таблицы":
· выделите блок А1:J1,
■
используйте кнопку "объединить"  на панели инструментов
ФОРМАТИРОВАНИЕ.
4.4. Аналогичным образом объедините ячейки и создайте  заголовки: «основная» и «вспомогательная».
4.5. Оформите заголовки определенными шрифтами:

4.6. Для заголовка «Таблицы» установите шрифт Arial Cyr, высота шрифта 14,
полужирный. Для заголовков "Основная" и "Вспомогательная" установите шрифт Arial
Суr, высота шрифта 12, полужирный. 

4.7. Для шапок таблиц установите шрифт Arial Суr, высота шрифта 12,
курсив. 

4.8. Подгоните ширину столбцов так, чтобы текст помещался полностью.

4.10.
Произведите выравнивание надписей шапок по центру.
Можно воспользоваться командой меню ФОРМАТ, ЯЧЕЙКИ. На экране появится диалоговое окно ФОРМАТ ЯЧЕЕК. В нем необходимо раскрыть вкладку ВЫРАВНИВАНИЕ.
4.11. Обрамите основную и вспомогательную таблицы и оформите в цвете ячейки
Упражнение 6. Знакомство с графическими возможностями Excel.
Построение диаграмм.
Цели работы:

■
познакомиться с различными типами диаграмм и графиков и научить​ся их строить;

■
освоить основные приемы редактирования и оформления диаграмм.
Одним из самых впечатляющих достоинств Excel является способность

превращать абстрактные ряды и столбцы чисел в привлекательные, информатив​ные графики и диаграммы. Excel поддерживает 14 типов различных двух- и трехмерных диаграмм.
Диаграммы - это удобное средство графического представления данных. 

ЗАДАНИЕ 1. Создайте таблицу

	
	июнь
	июль
	август
	сентябрь
	октябрь
	ноябрь
	всего

	Факел
	1050р.
	2100р.
	4260р.
	1950р.
	2281р.
	13891р.
	

	Книжный

мир
	330р.
	6160р.
	3630р.
	1220р.
	1100р.
	3174р.
	

	Детская 

книга
	950р.
	1000р.
	3000р.
	4000р.
	2350р.
	2869р.
	

	Всего
	
	
	
	
	
	
	


Рассчитайте ВСЕГО по строкам и столбцам.

ЗАДАНИЕ 2. Постройте диаграмму.
Построение диаграмм.
2.1.
Выделите всю таблицу.
2.2.
Щелкните по кнопке <Мастер диаграмм> панели   инструментов
Стандартная.
Шаг 1. Здесь Excel выводит первое диалоговое окно "Мастера Диаграмм Шаг 1 из 4" В окне показаны различные типы диаграмм, которые умеет строить Excel. Из них нужно выбрать и указать тип создаваемой диаграммы (Стандартный или Нестандартный) и ее вид.

2.3.
Выберите тип Гистограмма, тип - обычная, отображающая значе​ния различных категорий.
Шаг 2. Если окажется, что вы выделили не те или не все необходимые ячейки, то можно на этом месте еще раз произвести выбор.
2.4. С помощью мыши выделите группу ячеек А 1:H5.

2.5. Установите флажок «Ряды в строках»
Шаг 3. Здесь Excel предоставляет возможность поработать с несколькими вкладками.
Во вкладке Заголовки можно добавить название всей диаграммы, а также названия к каждой из осей (если таковые у вас имеются), результат немедленно отразится в диалоговом окне. 

2.6.
Введите для названия диаграммы текст «Выручка от реализации
книжной продукции», озаглавьте ось значений «количество в рублях», а ось кате​горий — «месяцы года».
Любая диаграмма имеет, по меньшей мере, одну ось. Все диаграммы, за исключением круговой и кольцевой, имеют не менее двух осей. Для того, чтобы убрать или добавить значения на осях координат, можно использовать вкладку Оси.

2.7.
Добавьте к диаграмме сетку, состоящую из основных линий.
С помощью вкладки Легенда можно добавить легенду к диаграмме, а так​же задать ее размещение относительно диаграммы (справа, слева и т.д.). Легенда содержит цветной (или узорчатый) код с описанием принадлежности его тому или иному ряду.
    2.8. Расположите легенду слева от диаграммы.
Кроме этого, на данном Шаге можно добавить к диаграмме таблицу значе​ний (с ключом легенды или без него), а также подписать каждый столбец или сек​тор (в зависимости от типа диаграммы), выбрав «значение» или «категория».

Если полученный результат вас не устраивает, то можно вернуться к пре​дыдущему диалогу, нажав кнопку <Назад>.
Шаг 4. На последнем шаге работы Мастер диаграмм предлага​ет вам разместить диаграмму на отдельном или на текущем листе, установив в диалоговом окне соответствующий флажок. Завершается работа с Мастером диа​грамм с помощью кнопки <Готово>.
2.10. Расположите диаграмму на отдельном листе и нажмите <Готово>

Вы получили диаграмму, расположенную на отдельном рабочем листе. Ес​ли вас что-то не устраивает в построенной диаграмме, то ее можно отредактиро​вать.

ЗАДАНИЕ 3. Перемещение и изменение размеров диаграммы.

Часто приходится изменять размеры и перемещать внедренную диаграмму для того, чтобы придать ей хороший вид или облегчить ее редактирование.

Для перемещения и изменения размеров диаграммы ее предварительно не​обходимо выделить.
Чтобы выделить диаграмму, поместите на ней указатель мыши и щелкните левой кнопкой мыши. Вокруг диаграммы появится тонкая рамка с размерными маркерами - маленькими черными квадратиками в углах и на серединах сторон рамки.
3.1. Скопируйте полученную диаграмму с отдельного листа и расположите её рядом с таблицей

3.2. Выделите диаграмму.
3.3. Переместите диаграмму до столбца I.

3.4. Измените размер диаграммы (растяните до столбца Р).
ЗАДАНИЕ 4. Изменение типа диаграммы

После того как выбран тип диаграммы с помощью Мастера диаграмм. Excel предоставляет большие возможности для изменения ее содержимого и вида.

Сначала необходимо щелчком мыши выбрать диаграмму для редактирова​ния. Вокруг диаграммы появится штриховая рамка или диаграмма окажется в ок​не. Затем с помощью панели инструментов Диаграмма можно изменить тип диа​граммы.
4.1. Укажите на любое место в диаграмме и щелкните мышью.
4.2. Выведите на экран панель инструментов Диаграмма. Меню: Вид, Па​нели инструментов, Диаграмма.
4.3. Щелкните по кнопке <Тип диаграммы>, которая содержит список
различных видов диаграмм.
Вид и названия диаграмм те же, что на Шаге 2. Для того чтобы построить новую диаграмму по имеющимся данным, просто выберите желаемый тип.
4.4.
Щелкните по кнопке понравившейся вам диаграммы.
4.5.
Попробуйте различные типы диаграмм и подберите наиболее нагляд​ный из них.
ЗАДАНИЕ 5. Постройте круговую объемную диаграмму для уже соз​данной вами таблицы.

Круговые диаграммы - наиболее часто используемый тип. Они подходят для наглядного представления долей, процентов, пропорций и других сопостав​ляемых значений.
Диаграмма построена, но на ней не хватает элементов оформления. Ее не​обходимо отредактировать.
ЗАДАНИЕ 6. Вырежьте кусочки из диаграммы.

7.1.
Выделите ряд данных. (Щелкните на области диаграммы).
7.2.
Щелкните внутри любого сектора.
Вокруг сектора появились квадратики, которые обозначают границу выде​ленного.
7.3. Удерживая левую кнопку мыши, отбуксируйте сектор в сторону на 1см.
7.4. Вырежьте еще 2 сектора.

ЗАДАНИЕ 7. Укажите в метках на диаграмме десятые доли %.

8.1  Щелкните внутри любого сектора правой кнопкой мыши и в контекстном меню выберите формат рядов данных и команду – Подписи данных, затем установите флажок на «доли», при этом должны появиться на диаграмме  возле каждой доли метка в процентном соотношении 
8.2
Выделите метки.
8.3
Выберите в контекстно-зависимом меню меток данных: Форматиро​вать метки данных, Число, 0,00%.

ЗАДАНИЕ 8. Измените фон диаграммы.

9.1. Щелкните мышью на области диаграммы.
9.2. Выберите в контекстном меню Формат области диаграммы, появится соответствующее диалоговое окно.
9.3. Выберите вкладку Вид и щелкните на каком-нибудь цвете в секции Заливка (например, светло-голубой). Нажмите ОК.
Выбранный цвет заливки применится ко всем областям диаграммы за исключением легенды, которая по-прежнему останется белой.
9.4. Аналогичным образом закрасьте легенду тем же цветом, предварительно щелкнув на ней и в контекстном меню выбрав Формат легенды.

9.5. Удалите рамку, ограничивающую область построения диаграммы, и рамку, ограничивающую легенду, выбрав во вкладке Вид соответствующего диалогового окна «Рамка»-«невидимая». Нажмите ОК.
ЗАДАНИЕ 9. Измените цвет секторов на узоры.

Так как при печати на черно-белом принтере цвет секторов не будет виден, то лучше использовать узоры.

10.1. Выделите сектор диаграммы.
10.2. Вызовите контекстно-зависимое меню и выберите: ФОРМАТИРО​ВАТЬ ЭЛЕМЕНТ ДАННЫХ, ВИД, ЗАКРАСКА ОБЛАСТИ, УЗОР.
10.3.
Подберите узоры всем секторам.

ЗАДАНИЕ 10. Измените легенду.

11.1,
Выделите легенду и вызовите контекстно-зависимое меню.
11.2.
Подберите шрифт, вид, размещение таким образом, чтобы легенда хорошо выглядела на графике.
ЗАДАНИЕ 11. Вставьте текст над легендой. 

На диаграмме можно расположить любой текст.

Вставка текста.
Для вставки свободного текста необходимо перейти в строку формул и на​чать вводить текст. После нажатия клавиши <ENTER> текст окажется в середине диаграммы, Его можно выделить и переместить в необходимое место на диаграм​ме.
12.1. Перейдите в строку формул и введите текст: КНИГИ-99.
12.2. Переместите текст на место заголовка к легенде.
 ЗАДАНИЕ 12. создайте следующую таблицу:
	Финансовая сводка за неделю (тыс.руб.)

	
	

	Дни недели
	Доход
	Расход
	Финансовый результат

	понедельник
	3 245,20
	3 628,50
	?

	вторник
	4 572,50
	5 320,50
	?

	среда
	6 251,66
	5 292,10
	?

	четверг
	2 125,20
	3 824,30
	?

	пятница
	3 896,60
	3 020,10
	?

	суббота
	5 420,30
	4 262,10
	?

	воскресенье
	6 050,60
	4 369,50
	?

	Ср.значение
	?
	?
	

	

	Общий финансовый результат за неделю:
	?


2.Рассчитайте средние значения Дохода и Расхода, пользуясь мастером функций (кнопка fx). Функция «Среднее значение» (СРЗНАЧ) находится в разделе «Статистические». Для расчета функции СРЗНАЧ дохода установите курсор в соответствующей ячей​ке для расчета среднего значения (В11), запустите мастер функ​ций (Вставка/Функция/категория — Статистические/СРЗНАЧ)
(рис. 8.5). В качестве первого числа выделите группу ячеек с данны​ми для расчета среднего значения — В4:В10.
Аналогично рассчитайте «Среднее значение» расхода.

3. Рассчитайте финансовый результат по формуле: Доход-Расход.
4.
В ячейке D13 выполните расчет общего финансового результа​та (сумма по столбцу «Финансовый результат»). Для выполнения автосуммы удобно пользоваться кнопкой Автосуммирования (() на панели инструментов или функцией СУММ. В качестве
первого числа выделите группу ячеек с данными для расчета сум​мы — D4:D10.
5.Постройте диаграмму (линейчатого типа) изменения финансовых результатов по дням недели с использованием мастера диаграмм.
Для этого выделите интервал ячеек с данными финансового результата и дни недели, одновременно (удерживая клавишу Ctrl), выберите команду Вставка/'Диаграмма. На первом шаге
 выберите тип диаграммы — линейчатая, на втором шаге введите название диаграммы и подписи осей; далее шаги построения диаграммы осуществляются автоматически по подсказкам мастера.

	Самостоятельная итоговая работа по MS Excel 
	

	
	
	
	
	
	
	
	

	Задание 1. Найдите значения функций, если даны переменные х и у, а также постоянные a и b
	

	
	
	
	
	
	
	
	

	x
	y
	a
	b
	z=x*x-y/a+y*b
	z=x*y-x/b+2*a
	z=x/b+(a+b)+x
	

	6
	2
	2
	6
	 
	 
	 
	

	6
	16
	 
	 
	 
	 
	 
	

	12
	5
	 
	 
	 
	 
	 
	

	-6
	8
	 
	 
	 
	 
	 
	

	24
	14
	 
	 
	 
	 
	 
	

	3
	-9
	 
	 
	 
	 
	 
	

	12
	9
	 
	 
	 
	 
	 
	

	12
	8
	 
	 
	 
	 
	 
	

	24
	3
	 
	 
	 
	 
	 
	

	
	
	
	
	
	
	
	

	Задание 2. Протабулировать функцию у=2к+(х^3+4y) для х на интервале (1;15) с шагом 1; у на интервале (5;33) с шагом 2 и постоянной к=5
	

	
	

	Задание 3.Создайть таблицу количества неуспевающих студентов по курсам, подсчитать нужные значения и построить 2 круговых диаграммы, которые показывают количество неуспевающих студентов по курсам за оба семестра и гистограмму среднего значения по курсам. Диаграммы должны содержать заголовки и оформление
	

	
	

	
	

	
	
	2007г.
	

	 
	 
	1 семестр
	2 семестр
	ср. знач
	

	1 курс 
	 
	10
	15
	 
	

	2  курс
	 
	13
	17
	 
	

	3 курс 
	 
	15
	19
	 
	

	4 курс 
	 
	14
	10
	 
	

	всего:
	 
	 
	 
	

	миним.
	 
	 
	 
	

	максим.
	 
	 
	 
	

	
	
	
	
	
	

	Задание 4 Заполнить таблицу анализа продаж, произвести расчеты, выделить минимальную и максимальную продажи. Построить диаграмму выручки от продаж.

Формулы для расчета:

Всего = Безналичные платежи + Наличные платежи;

Выручка от продажи = Цена х Всего.
АНАЛИЗ ПРОДАЖ продукции фирмы "Интертрейд" за текущий месяц
Наименование продукции

Цена (руб.)

Продажи

Выручка
продаж
(РУб.)

Безналичные платежи (шт.)
Наличные платежи (шт.)
Всего (шт.)
Видеотелефон

4 200

240

209

Телевизор

9 500

103

104

Видеомагнитофон
6 250

76

45

Музыкальный центр
12 750

10

17

Видеокамера
13 790

57

45

Видеоплеер
4 620

104

120

Аудиоплеер

450

72

55

 видеокассеты

120

516

247

Итого:
Максимальные продажи
Минимальные продажи


	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	


Создание графических векторных изображений

Приемы работы с графическим редактором Paint
[image: image3.png]



В этом упражнении мы создадим условное обозначение вольтметра, принятое на электрических схемах.

1. Запустите графический редактор Paint (Пуск > Программы > Стандартные t Paint).

2. Убедитесь, что на палитре задан черный цвет в качестве основного и белый — в качестве фонового.

3. Дайте команду Рисунок > Атрибуты, в диалоговом окне Атрибуты задайте ширину рисунка, равную 300 точек и высоту — 200 точек. Щелкните на кнопке ОК.

4. Выберите инструмент Эллипс и в палитре настройке инструмента укажите вариант Без заполнения.

5. Нажмите и удерживайте клавишу SHIFT. Методом протягивания нарисуйте окружность в центральной части области рисунка. Диаметр окружности должен составлять около половины высоты рисунка. Отпустите клавишу SHIFT.

6. Выберите инструмент Линия. В палитре настройки инструмента выберите вариант толщины линии (второй сверху).

7. Нажмите и удерживайте клавишу SHIFT. Методом протягивания нарисуйте небольшой горизонтальный отрезок прямой в стороне от окружности. Отпустите клавишу SHIFT.

8. Выберите инструмент Выделение. В палитре настройки инструмента выберите режим с прозрачным фоном.

9. Методом протягивания выделите прямоугольный фрагмент, охватывающий нарисованный отрезок прямой, но не затрагивающий окружность. Комбинацией клавиш CTRL+X поместите его в буфер обмена,

10. Вставьте отрезок прямой на рисунок комбинацией клавиш CTRL+V. Обратите внимание, что выделение при этом сохраняется.

11. Переместите выделенный фрагмент так, чтобы отрезок прямой примыкал к окружности слева. Обратите внимание на то, что фоновая часть фрагмента не перекрывает окружность.

12. Повторите операции, описанные в пп. 10-11, чтобы создать отрезок прямой,  примыкающий к окружности справа.

13. Выберите инструмент Текст.

14. Методом протягивания создайте область ввода текста внутри окружности. Введите символ «V». С помощью панели Шрифты задайте подходящий размер и начертание шрифта.

15. Методом перетаскивания за границу области ввода текста поместите букву «V» в центре окружности.

16. Щелкните вне области ввода текста, чтобы превратить текст в часть рисунка.

17. Сохраните созданное изображение под именем scheme.bmp.

Упражнение1. Настройка интерфейса CorelDraw и параметров документа
1. Запустите программу CorelDraw (Пуск > Программы > CorelDraw  > CorelDraw ).

2. В открывшемся окне Welcome to CorelDraw (Добро пожаловать в CorelDraw) щелкните на кнопке New Graphics (Создать).

3. На панели свойств щелкните на кнопке Options (Параметры).

4. В открывшемся окне Options (Параметры) в разделе Workspace (Рабочая область) выберите строку Edit (Изменение). В разделе Duplicate Placement (Повторить положение) установите на счетчиках Horizontal (По горизонтали) и Vertical (По вертикали) значения 5 мм. В разделе Nudge (Смещение) установите счетчиком Nudge (Шаг смещения) значение 1 мм.

5. Раскройте раздел Document (Документ), выберите строку General (Общие), в раскрывающемся списке Display (Отобразить) выберите строку Enhanced View (Качественный). Выберите строку Grid (Сетка), установите переключатель Spacing (Интервал), в разделе Spacing (Интервал) установите счетчиками Horizontal place a grid line every (По горизонтали помещать точки сетки через) и Vertical place a grid line every (По вертикали помещать точки сетки через) значения 5 мм. Установите флажок Show Grid (Показывать сетку).

6. Выберите строку Styles (Стили). На вкладке Styles (Стили) в окне выберите строку Default Graphics (По умолчанию для графики), в строке Outline (Абрис) на правом поле щелкните на кнопке Edit (Изменить). В открывшемся окне Outline Pen (Атрибуты абриса) счетчиком Width (Толщина) установите значение 1 пункт, щелчком на кнопке ОК закройте окно.

7. На вкладке Styles (Стили) в окне выберите строку Default Artistic Text (По умолчанию для фигурного текста). На правом поле в строке Text (Текст) щелкните на кнопке Edit (Изменить). В открывшемся окне Format Text (Форматирование текста) на вкладке Font (Шрифт) в разделе Font Properties (Свойства шрифта) в раскрывающемся списке Font (Шрифт) выберите шрифт без засечек, например Arial Cyr. Счетчиком Size (Размер) установите величину кегля 12 пунктов. Перейдите на вкладку Align (Выравнивание), в разделе Alignment (Выравнивание) установите переключатель типа выравнивания Center (По центру). Щелчком на кнопке ОК закройте окно.

8. На вкладке Styles (Стили) в окне выберите строку Default Paragraph Text (По умолчанию для простого текста) и повторите действия, изложенные в пункте 7.
9. В окне Options (Параметры) раскройте пункт Page (Страница), перейдите на строку Size (Размер). Установите переключатели Normal Paper (Обычная бумага) и Portrait (Книжная). В раскрывающемся списке Paper (Бумага) выберите формат А4.

10. Вернитесь к разделу Document (Документ). Установите флажок Save options as defaults for new documents (Сохранить параметры, как действующие по умолчанию для новых документов) и все активизировавшиеся после этого флажки.

11.  Перейдите в раздел Workspace (Рабочая область), раскройте пункт Customize (Настройка), выберите строку Shortcut Keys (Клавиши быстрого вызова). На вкладке Shortcut Keys (Клавиши быстрого вызова) раскройте папку Editing Commands (Команды правки), которая находится внутри папки Edit &Transform (Правка и преобразование), выберите строку Duplicate (Дублировать). Установить курсор в поле Press new shortcut keys (Нажмите новые клавиши быстрого вызова) и нажмите сочетание клавиш CTRL+D.

12. В окне Options (Параметры) перейдите на строку Toolbars (Панели инструментов). В окне вкладки Toolbars (Панели инструментов) раскройте папку Align & Distribute (Выравнивание и распределение), которая находится внутри папки Arrange (Монтаж). В раскрывающемся списке Property Bar (Панели свойств) выберите строку Multiple Objects (Несколько объектов).

13. Щелчком на кнопке ОК закройте окно Options (Параметры).

Упражнение 2. Составление схемы
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Рис. Возможный вид создаваемой схемы

1. Выберите инструмент Rectangle Tool (Прямоугольник), протягиванием нарисуйте прямоугольник. На панели свойств в полях Object Size (Размер объекта) установите размер по горизонтали 50 мм, по вертикали 20 мм. В поле у Object Position (Положение объекта) установите значение 270 мм.

2. Откройте окно Align and Distribute (Выровнять и распределить) командой Arrange > Align and Distribute (Упорядочить > Выровнять и распределить). В разделе Align to (Выровнять) установите флажок Center of Page (По центру страницы), в левой части окна сбросьте флажок Center (По центру). Щелчком на кнопке ОК закройте окно.

3. Выберите инструмент Text Tool (Текст). Щелкните на свободном поле страницы и наберите текст «Ректорат».

4. Выберите инструмент Pick Tool (Указатель). Удерживая в нажатом положении клавишу SHIFT, выберите последовательно текстовый объект и прямоугольник. На панели свойств щелкните на кнопке Align (Выровнять и распределить). В открывшемся окне Align and Distribute (Выровнять и распределить) установите флажки Center (По центру) среди левых и верхних элементов управления выравниванием.

5. Инструментом Pick Tool (Указатель) выберите прямоугольник. Сделайте его дубликат, нажав сочетание клавиш CTRL+D. Щелчком левой кнопки мыши на белом цвете в палитре цветов присвойте дубликату значение заполнения.

8. Перетаскиванием переместите дубликат так, чтобы его координата у имела значение 230 мм. При необходимости выставьте это значение на панели свойств.

9. Инструментом Pick Tool (Указатель) последовательно выберите дубликат и исходный прямоугольник. На панели свойств щелкните на кнопке Align (Выровнять и распределить), В открывшемся окне Align and Distribute (Выровнять и распределить) установите флажок Center (По центру) среди верхних элементов управления выравниванием.

10. Выберите инструмент Text Tool (Текст). Переместите курсор к контуру дубликата так, чтобы рядом с ним появились символы АВ в рамке. После этого щелкните мышью и наберите текст «Факультеты». На панели свойств щелчком на раскрывающей кнопке Vertical Alignment (Выравнивание по вертикали) выберите вариант выравнивания Center (По центру).

11. Инструментом Pick Tool (Указатель) выберите дубликат. Приемом, описанном в пункте 7, создайте две его копии. Выберите первую копию и щелчком на кнопке То Back (Ниже всех) на панели свойств переместите ее на задний план. То же самое проделайте для второй копии.

12. Выберите копии дубликата, начиная с нижней. На панели свойств щелчком на кнопке Group (Группировать) сгруппируйте объекты. Щелчком на кнопке отражения по вертикали Mirror Buttons (Кнопка Зеркало) переверните полученный объект. Переместите сгруппированный объект курсорной клавишей ВНИЗ до значения координаты у, равного 222,5 мм.

13. Протягиванием инструмента Pick Tool (Указатель) выберите дубликат и его копии и сгруппируйте в один объект.

14. Повторив пункты 7,10 (набрав текст «Вспомогательные подразделения»), создайте новый объект с координатами х, у (45; 230).

15. Выберите инструмент Ellipse Too! (Эллипс), протягиванием нарисуйте эллипс с параметрами ширины и длины 50 и 20 мм соответственно.

16. Используя приемы, описанные в пункте 9, выровняйте эллипс по вертикали относительно соседних объектов — флажок Тор (По верхнему краю).

17. Используя приемы, описанные в пункте 5, наберите текст «Проректор».

18. Инструментом Pick Tool (Указатель) последовательно выберите текстовый объект и эллипс. Дайте команду Text > Fit Text To Path (Текст > Текст вдоль кривой). На панели свойств счетчиком Distance from Path (Расстояние от кривой) установите значение — 6 мм.

19. Выберите инструмент Interactive Connector Tool (Интерактивное соединение) и соедините с его помощью элементы схемы прямыми линиями.

20. Выберите инструмент Polygon Tool (Многоугольник), на панели свойств установите значение счетчика числа углов равным 8, протягиванием нарисуйте восьми угольник. Присвойте фигуре значение заполнения цветом 20% Black (Серый 20%).

21. Выровняйте восьмиугольник относительно группы объектов «Факультеты» по координате х по центру. Установить значение координаты у равным 170.

22. Используя изученные ранее приемы, разместите в центре восьмиугольника надпись «Кафедры».

23. Используя инструмент Connector Line Tool (Соединительная линия), соедините восьмиугольник с объектом «Факультеты».

24. Используя инструмент Interactive Drop Shadow Tool (Интерактивная падающая тень), протягиванием от центра фигуры создайте тень со следующими параметрами:

· координаты х, у (7; -5);

· Drop Shadow Opacity (Темнота падающей тени) = 50;

· Drop Shadow Feathering (Оперение падающей тени) = 15;

· Feathering Direction (Направление падающей тени) = Average (Средний);

· Perspective Type (Тип перспективы) = Flat (Плоский).

Применяя изученные приемы, завершите схему так, чтобы она соответствовала представленной на рисунке.
Упражнение 2. Построение упрощенного чертежа разреза зубчатого колеса

1. Откройте новый документ

2. Чертеж требует высокой точности графики. Поэтому необходимо поменять некоторые установки параметров документа. Щелчком на кнопке Options (Параметры) панелисвойств откройте диалоговое окно Options (Параметры). Откройте раздел Document (Документ) и перейдите к строке Grid (Сетка). На вкладке Grid (Сетка) установите переключатель Frequency (Число линий), счетчиками выставьте значение 10 по горизонтали и вертикали. Установите флажки Show Grid (Показывать сетку) и Snap to Grid (Привязывать к сетке). Перейдите к разделу Guidelines (Направляющие), установите флажок Snap to Guidelines (Привязать к направляющим). Щелчком на кнопке ОК закройте окно.

4. Для задания габаритов чертежа следует создать направляющие линии. Установите указатель мыши на вертикальную измерительную линейку и протягиванием перетащите направляющую линию в область чертежа. На панели

свойств счетчиком х выставьте значение 20 мм. Следующие линии выставьте в

положение х = 70 мм и х= 100 мм. Вертикальные направляющие выставьте вположения у = 250 мм, у = 160 мм, у = 70 мм.

5. Прежде чем начинать рисование, надо задать толщину контуров, принятую по умолчанию. Щелчком на кнопке Outline Tool (Абрис) на панели инструментов откройте диалоговое окно Outline Pen (Перо абриса), установите флажок Graphics (Графика), щелчком на кнопке ОК закройте окно, в открывшемся диалоговом окне Outline Pen (Атрибуты абриса) в разделе Width (Толщина) в раскрывающемся списке единиц измерения выберите пункт millimeters (миллиметров), счетчиком Width (Толщина) выставьте значение 0,6. Щелчком на кнопке ОК закройте окно.

6. Выберите инструмент Rectangle Tool (Прямоугольник), нарисуйте прямоугольник размером 50x90 мм с координатами центра х, у (45; 115). Откройте стыкуемую палитру Object Manager (Диспетчер объектов) командой Window > Dockers > Object Manager (Окно> Закрепления > Диспетчер объектов), присвойте прямоугольнику имя 01. Щелчком правой кнопки мыши на палитре цветов присвойте контуру цвет Red (Красный).

7. На панели свойств щелчком на кнопке Rounds Corners Together (Скруглять углы синхронно) отключите режим взаимосвязанного изменения радиусов закругления углов. Счетчиками Left Rectangle Corner Roundness (Скругление левых углов прямоугольника) и Right Rectangle Corner Roundness (Скругление правых углов прямоугольника) выставьте значение 10 для нижних углов.

8. Нарисуйте прямоугольник (см. п. 6) размером 50x70 мм с координатами центра х, у (45; 115). Присвойте ему имя 02.

9. Нарисуйте прямоугольник размером 20x50 мм с координатами центра х, у (30; 115). Присвойте ему имя 03. Выставьте значение скругления его правых углов 20. Дав команду Effects > Add Perspective (Эффекты > Добавить перспективу), измените перспективу перетаскиванием нижней правой управляющей точки (при нажатом сочетании клавиш CTRL+SHIFT) по вертикали до появления в строке состояния Vanishing Point (Hoz) (Точка схода (гор)) значения 461 мм.

10. Создайте дубликат прямоугольника 03 (CTRL+D), зеркально отразите его по горизонтали, установите координаты центра х, у (60; 115), присвойте объекту имя 04.

11. Нарисуйте прямоугольник размером 30x10 мм с координатами центра*,у (85; 145), выставьте значение скругления правого нижнего угла 60, присвойте ему имя 05. Дав команду Effects > Add Perspective (Эффекты > Добавить перспективу), измените перспективу перетаскиванием нижней правой управляющей точки по вертикали до появления в строке состояния значения Vanishing Point (Hoz) (Точка схода) примерно 255 мм.

12. Откройте стыкуемую палитру Shaping (Объединение) командой Window > Dockers Shaping > Weld (Окно > Закрепления > Преобразование > Объединение). Выберите прямоугольник 05. Щелкните на кнопке Weld To (Объединение с) и укажите прямоугольник 02. Назначьте контуру итогового объекта цвет Green (Зеленый), оставьте имя 02.

13. Выберите прямоугольник 04, в стыкуемой палитре Shaping (Объединение) переключитесь в режим Trim (Пересечение), сбросьте все флажки Leave Original (Сохранить оригинал), щелкните на кнопке Trim (Пересечение с), укажите объект 02.

14. Повторите операцию (см. п. 13) с прямоугольником 03.

15. Выделите все объекты, сделайте дубликат, отразите его зеркально по вертикали, переместите дубликат в положение х, у (60; 205).

16. Выберите прямоугольник 01, дайте команду Weld To (Объединить с) и укажите дубликат прямоугольника 01. Присвойте дубликату объекта 02 имя 02а.

17. Нарисуйте прямоугольник размером 80x20 мм с координатами централ:, у (60; 160), присвоить ему имя 06, назначьте цвет контура Cyan (Голубой).

18. Нарисуйте прямоугольник размером 80x3 мм с координатами централт, г/ (60; 171,4), присвойте ему имя 07, назначьте цвет контура Cyan (Голубой).

19. Последовательно выберите прямоугольники 06 и 07 и скомбинируйте их. Присвойте заполнению цвет White (Белый). Присвойте итоговому объекту имя 08.

20. Выберите объекты 02 и 02а, продублируйте их, присвойте заполнению цвет White (Белый), переместите на задний план командой Arrange > Order > To Back (Упорядочить > Порядок > Ниже всех), переместите их в положением, у (60; 160), сгруппируйте объекты, присвойте результату имя Group 01. Выберите объект 01, переместите его на задний план. Сгруппируйте объекты 02 и 02а, присвойте результату имя Group 02. Командами Arrange > Order (Упорядочить > Порядок) разместите объекты в следующей последовательности (сверху вниз): 08, Group 02, Group 01, 01.

21. Выберите объект Group 01, щелчком на кнопке Fill Tool (Заливка) на панели инструментов откройте вложенную панель и щелчком на кнопке PostScript Fill Dialog (Диалог Заливка узором PostScript) откройте окно PostScript Texture (Заливка PostScript). Выберите строку Hatching, счетчиками установите параметры: Мах distance (Максимальное расстояние) = 50, Min distance (Минимальное расстояние) = 50, Line width (Ширина линии) = 5, Angle (Угол) = 45, Random seed (Случайный отсчет) = 0.

22. Инструментом Bezier Tool (Кривая Безье) проведите линию длиной 100 мм с координатами х, у (60, 160). На панели свойств установите ее свойства: Width (Толщина) = 0,353 мм; Outline Style Selector (Выбор стиля абриса) — штрих-пунктир.

23. Инструментом Bezier Tool (Кривая Безье) проведите линию длиной 60 мм с координатами х, у (45,245). На панели свойств задайте ее свойства: Width (Толщина) = 0,353 мм; Outline Style Selector (Выбор стиля абриса) — штрих-пунктир. Создайте такую же линию с координатами х, у (45; 75).

24. Выберите все объекты, присвойте контурам цвет Black (Черный), сгруппируйте объекты. При необходимости сохраните чертеж под именем, указанным инструктором.
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